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введение

Методические указания по проведению лабораторных работ в курсе изучения дисциплины «Базы данных» предназначено для студентов технического колледжа специальности 2202  "Автоматизированные системы обработки информации и управления (по отраслям)"
Цель руководства: оказание помощи студентам при подготовке и выполнению лабораторных работ по дисциплине «Базы данных». Во время проведения лабораторных  работ студенты применяют знания, полученные при изучении теоретической части курса.

Правила внутреннего распорядка в компьютерном классе:

· Руководителем при выполнении лабораторных работ является преподаватель дисциплины «Базы данных».

· Без преподавателя вход студентов на ВЦ НТК запрещается.

· Перед началом работы необходимо проверить комплектность рабочего места.

· Студент должен заполнять контрольный лист на своём рабочем месте во время каждого сеанса работы.

· После окончания работы необходимо корректно выйти из сети и выключить компьютер.

· В случае неисправности оборудования необходимо поставить в известность руководителя.

· После окончания лабораторных работ рабочее место должно быть приведено в порядок: поставлены на место стулья. 
· Выполнение пропущенных лабораторных работ производится в дни и часы, установленные преподавателем.

· Выполнять на компьютере операции, не предусмотренные заданиями к лабораторной работе, запрещается!

· Выполнять операции на компьютере под чужим паролем, попытки нарушить несанкционированный доступ к информации запрещается! 

· При нахождении в компьютерном классе студенты должны соблюдать правила техники безопасности.

Правила техники безопасности:

К выполнению лабораторных работ допускаются студенты, получившие инструктаж по технике безопасности у преподавателя, ведущего занятия. В специальном контрольном листе делается соответствующая запись о получении инструктажа и в дальнейшем студент обязан выполнять установленные правила техники безопасности.

Запрещается

· хождение студентов в компьютерном классе во время занятий;

· присутствие на занятии посторонних;

· хождение в пальто, куртках;

· самостоятельно устранять неисправности оборудования;

· производить работы на неисправном оборудовании;

· оставлять включенное оборудование на рабочем месте без наблюдения;
· приносить и использовать дискеты без уведомления преподавателя;

Лица, обнаружившие неисправность оборудования должны немедленно сообщить об этом лаборанту или преподавателю, ведущему занятие.

В случае поражения электрическим током человека необходимо:

· освободить пострадавшего от действия тока (отключить напряжение);

· оказать доврачебную помощь (расстегнуть одежду, создать приток свежего воздуха, дать нюхать нашатырный спирт, при резком и судорожном дыхании делать искусственное дыхание), вызвать врача;

· сообщить о неисправности преподавателю; 

Порядок выполнения лабораторных работ:
На первом лабораторном занятии руководитель работ знакомит студентов с правилами техники безопасности, с правилами внутреннего распорядка в компьютерном классе, с оснащением класса с особенностями работы в сети в качестве клиента файлового сервера.

О предстоящей лабораторной работе студенты уведомляются заранее.

Для выполнения каждой последующей работы, студенты дома по настоящему руководству знакомятся с содержанием лабораторной работы, усваивают ее цели, теоретические сведения, продумывают решение указанных задач.

Руководитель работ проверяет подготовленность студента с помощью экспресс опроса. Неподготовленные студенты к выполнению работы не допускаются.

Студенты, допущенные к лабораторной работе, выполняют ее на закрепленных за ними рабочих местах. 
Для хранения файлов созданных во время лабораторных работ требуется создать отдельную папку. 
После выполнения студентами заданий к лабораторной работе преподаватель проверяет на компьютере правильность выполнения заданий, указывает недостатки, ошибки, допущенные студентом.

Отчет о выполненной работе оформляется в виде текстового документа или в электронной форме по усмотрению преподавателя. 

Отчёт содержит:
· номер и название лабораторной работы;

· ответы на вопросы к работе;

· задания и команды, необходимые для их выполнения;

Рекомендованная литература:
1. Савицкий Н.И. Технологии организации, хранения и обработки данных: Учеб. пособие М.: ИНФРА-М, 2001.

2. Мусина Т.В., Птушенко В.А. Visual FoxPro 7.0. Учебный курс – К.: век, К.: BookStar , 2001.

3. Агальцов В.П. Базы данных: Учебное пособие. М.: Мир, 2002.

4. Методические указания к проведению лабораторных работ по дисциплине «Базы данных», НТК, 2004г.

Лабораторная работа N 1.

Тема: «Основы работы в среде VFP. Создание  таблицы: определение структуры и заполнение таблицы данными»

Цель работы: Изучение среды Visual FoxPro9.0. Выполнение операций по созданию файла таблицы.

Запуск СУБД: Пуск, Программы, MicVisualStudio, Visual FoxPro7.0.
Интерфейс СУБД: главное окно содержит: системное меню, панель инструментов, командное окно. 

      
[image: image1.png]Microsoft Visual FoxPro [_[O]x]
Fie Edt View Fomat Toos Progiam indow Help

D[] Sl [ el S| 2l F e =l sla] Al 2

H UM [ Y





<F10>-войти в меню.

<Ctrl>+<F2>-отображение командного окна поверх всех окон.

В командное окно можно вводить одну или несколько команд и выполнить их, нажав <Enter>. В этом окне прописываются системные команды для установки рабочей среды.  Кроме того, системные установки производятся из системного меню VFP: Tools/Options. Из командного окна можно выполнять команды создания, просмотра и модификации БД.

Задание:
Создать структуру для трёх таблиц и заполнить таблицы данными.
Таблицы: 

СТУДЕНТ(ФАМ, ГРУППА, №ЗАЧЕТКИ); 
ПРЕПОДАВАТЕЛЬ(ФАМ, ПРЕДМЕТ); 

ЭКЗАМЕН (ПРЕДМЕТ, ОЦЕНКА,  №ЗАЧЕТКИ ).

Выполнение задания:

1. Создайте папку БД для хранения файлов лабораторных работ  в VFP.

2. Установите активной по умолчанию папку БД (возможны два способа): 

· В окне Command введите и исполните команду set default to <ПУТЬ>.
· В главном меню команды Tools>Options, вкладка File locations, в строке Default Directory ввести имя каталога по умолчанию, щёлкнуть по кнопке [Set All Default], [Ok].

3. Создайте три таблицы, используя различные возможности VFP:

· В конструкторе таблиц

· Из меню командами File>New>Table, кнопка [New File], ввести имя таблицы, щёлкнуть кнопку  [Сохранить]. В окне Table Designer на вкладке Fields ввести: в колонку Name имя поля (атрибут), в колонку Type – тип поля, в колонку Width – ширину поля. (Тип символьный – C(лат.), числовой – N)

· После создания структуры таблицы – [Ok].

· На вопрос ‘Input date records now?’(Ввести данные в таблицу?) ответить “Yes”.

· Введите данные в таблицу. Образовать не менее пяти записей в каждой таблице. Записи должны соответствовать реальным данным.

· С помощью мастера таблиц. В системном меню выбрать команды Tools>Wizard>Table или  File>New>Table, кнопка [Wizard]. Выполнить последовательно шаги (Step). Переход к следующему шагу – кнопка [Next]. На последнем, четвёртом шаге выбрать [Save table and browse it] и щёлкнуть [Finish]. Далее заполнить таблицу данными.

· С помощью команды create table <имя таблицы >( <имя поля > <тип>(<ширина поля>),  и т.д.) в окне Command.

Контрольные вопросы к работе:

1. Как и для чего создаётся таблица?
2. Какова структура таблицы?

3. Что определяет тип поля таблицы?
4. Какие типы полей возможны в Visual FoxPro7.0?
5. Каковы способы создания структуры таблицы в СУБД Visual FoxPro7.0?

Лабораторная работа №2.

Тема: Операции над таблицами: редактирование и просмотр данных в среде VFP.

Задания:

1. Откройте таблицу СТУДЕНТ из командного окна (USE СТУДЕНТ).

2. Просмотрите содержимое таблицы (BROWSE).

3. Отредактируйте таблицу -  добавьте значения Memo-поля БИОГРАФИЯ и логического поля КОМ (коммерческое обучение).
4. Просмотрите только Memo-поля таблицы STUD:

SET HEADING OFF  (НЕ ВЫВОДИТЬ ЗАГОЛОВОК ПОЛЯ)

SET MEMOWIDTH TO 20 (УСТАНОВИТЬ ШИРИНУ ВЫВОДА 20)

DISPLAY БИОГРАФИЯ (ВЫВЕСТИ ЗНАЧЕНИЕ ПОЛЯ БИОГРАФИЯ ТЕКУЩЕЙ                              ЗАПИСИ)

DISPLAY ALL OFF БИОГРАФИЯ (ВЫВЕСТИ ЗНАЧЕНИЯ ПОЛЯ БИОГРАФИЯ ДЛЯ ВСЕХ ЗАПИСЕЙ БЕЗ НОМЕРОВ ЗАПИСЕЙ)

5. Используйте команду BROWSE для просмотра и редактирования данных с контролем значений полей (проверьте работу всех ключей):

· Запретить редактировать поле ФАМИЛИЯ.

· Вывести фамилии коммерческих студентов одной из групп.

· Вывести для бюджетных студентов номера зачеток и значения Мemo-полей, установить контроль ввода значений для поля №ЗАЧЁТКИ – номер не должен быть меньше 100 или больше 500. Установить при ошибке вывод в строку статуса главного окна сообщение «ТАКИХ ЗНАЧЕНИЙ НЕ МОЖЕТ БЫТЬ!», заголовок поля ФИО вывести как БЮДЖЕТНИКИ (ключ : Н=<заголовок>). 

6. Дополните Memo-поля таблицы только для одной группы, используя команду REPLACE <поле> WITH <выражение> ADDITIVE  FOR <логическое выражение>.

7.  Измените номер зачётки  у одного из студентов, используя команду REPLACE <поле> WIDTH <выражение> FOR <логическое выражение>

8. Пометьте на удаления записи, относящиеся к коммерческим студентам, используя команду DELETE FOR <лог. выражение> 

9. Просмотрите только те записи, которые не помечены на удаление, используя команду BROWSE FOR NOT DELETED().

10. Просмотрите все записи.

11. Сделайте системную установку, в результате которой помеченные на удаления записи не обрабатываются –SET DELETED ON.

12. Просмотрите все записи.

13. Сбросьте признак  на удаление записей командой RECALL ALL.

14. Просмотрите все записи.

15. Удалите информацию об одном из студентов физически командой PACK.

Контрольные вопросы к работе:

1. Какими способами можно выводить данные из таблицы на экран?
2. Как производится добавление полей в таблицу?

3. Какие ключи есть у команды BROWSE и как они используются при вводе и редактировании данных?

4. Каковы особенности работы с полями типа MEMO?
5. Какие средства существуют для удаления записей?

6. Как можно использовать помеченные на удаление записи?

Лабораторная работа №3.

Тема: «Поиск данных в неупорядоченных и упорядоченных таблицах».
Задания:

1. Установите фильтр для отображения информации только о коммерческих студентах одной из групп таблицы СТУДЕНТ.DBF.

                 SET FILTER TO КОМ. 

                 Проверьте работу фильтра – просмотрите записи таблицы.

2. С помощью фильтрации отобразите записи о студентах, фамилия которых начинается на букву «С». Используйте для задания фильтра логическое выражение «С» $ ФАМ.

3. Снимите фильтр командой SET FILTER TO.

4. Используя установку указателя на запись с заданным значением поля, выведите номера записей и фамилии всех студентов из одной группы. Используйте команды:

 LOCATE FOR ГРУППА=<НОМЕР ГРУППЫ>    && УКАЗАТЕЛЬ НА ИСКОМУЮ ЗАПИСЬ
 DO WHILE FOUND()      && ПОВТОРЯТЬ, ПОКА НАЙДЕНА ЗАПИСЬ
 ? RECNO(), ФАМ       &&  ?-ЭТО КОМАНДА ВЫВОДА НА ЭКРАН, 

                                          &&  RECNO()- ФУНКЦИЯ, ВОЗВРАЩАЕТ НОМЕР ТЕКУЩЕЙ ЗАПИСИ.

CONTINUE        && ПРОДОЛЖИТЬ ПОИСК
ENDDO              && КОНЕЦ ЦИКЛА

{ЗНАК “&&” ОЗНАЧАЕТ КОММЕНТАРИЙ} 

5. Используя установку указателя на запись с заданным значением поля таблицы ЭКЗАМЕН.DBF, выведите номера записей и номера зачёток  всех студентов, имеющих 5 либо по физике, либо по математике.

6. Проиндексируйте таблицу СТУДЕНТ по полю ГРУППА и по полю № ЗАЧЁТКИ, создайте два файла: idgr.idx и idnum.idx. Используйте команды: 

                      INDEX ON ГРУППА TO idgr

                      INDEX ON №ЗАЧЁТКИ TO idnum ADDITIVE

7. Закройте таблицу.

8. Откройте таблицу СТУДЕНТ в двух областях: с индексом idgr.idx в области 1 и с индексом idnum.idx в области 2. Запретить редактирование обеих таблиц. Используйте команды:

                          USE STUD INDEX IDGR.IDX IN 1 NOUPDATE

   USE STUD INDEX INUM.IDX IN 2 AGAIN NOUPDATE   

9. Просмотреть таблицы в областях 1, 2. Используйте команду для активизации рабочих областей:  SELECT <РАБОЧАЯ ОБЛАСТЬ>. Проверьте, как меняется результат работы команды BROWSE в зависимости от используемого индекса.

10. Откройте таблицу СТУДЕНТ в области 3 с двумя индексами. Используйте команды: USE <ИМЯ ТАБЛИЦЫ> INDEX <ИНДЕКС 1>,<ИНДЕКС 2 > IN <ОБЛАСТЬ>

            Проверить, как влияет индексный порядок на действие команд просмотра таблиц.

11. Выполнить поиск данных в упорядоченных таблицах, используя команды :

                    FIND <ИСКОМОЕ ЗНАЧЕНИЕ СИМВОЛЬНОГО ПОЛЯ> - указатель текущей записи  устанавливается  на первую по порядку запись с заданным значением поля, по которому предварительно проиндексирована таблица. Эта команда служит для поиска значений только символьных полей.

                   SEEK <ИСКОМОЕ ЗНАЧЕНИЕ ПОЛЯ> - указатель текущей записи устанавливается на первую по порядку запись с заданным значением поля, по которому предварительно проиндексирована таблица, и возвращается номер записи. Команда служит для поиска  значений полей любого типа (кроме GENERAL и MEMO). Если запись не найдена указатель ставится на конец файла. Особенно удобно использовать эту команду для приблизительного поиска по индексированному числовому полю или полю типа дата. Если предварительно есть установка SET NEAR ON, то указатель ставится на ближайшую подходящую по значению индекса запись.
Контрольные вопросы к работе:

1. Что представляет  собой индекс?
2. Какие типы индексов вы знаете?
3. Для каких целей используется индексирование таблиц?
4. Для каких целей используется перестройка индексных файлов?
5. Какие есть способы сортировки данных в таблице?
6. Какие способы сортировки данных можно использовать и в каких случаях?
7. Для чего используется фильтрация данных в таблицах?
Лабораторная работа №4.

Тема: «Связывание таблиц командным и визуальным способом. Создание представлений и использование файла представлений».

Задания:
1. Установите между таблицами СТУДЕНТ и ЭКЗАМЕН отношение 1:1, используя команды FoxPro:

a) Откройте таблицу в СТУДЕНТ области 1 и таблицу  ЭКЗАМЕН в области 2.

b) Создайте индекс i_num по полю  №ЗАЧЕТКИ  для таблицы ЭКЗАМЕН.

c) Сделайте активной область 1.

d) Установите отношение 1:1 от родительской таблицы СТУДЕНТ к дочерней ЭКЗАМЕН, для этого выполните команду: SET RELATION TO №ЗАЧЕТКИ  INTO 2.

e) Выполните команду просмотра поля ФАМ таблицы СТУДЕНТ и полей ПРЕДМЕТ, ОЦЕНКА  таблицы ЭКЗАМЕН только для коммерческих студентов. 

2. Установите между таблицами  СТУДЕНТ и ЭКЗАМЕН отношение 1:М, используя команду FoxPro: SET SKIP TO 2.

3. Выполните команду 1.е. Сравните полученные результаты.

4. Установим отношения  между таблицами иным способом. Свяжем таблицы  ЭКЗАМЕН  и ПРЕПОДАВАТЕЛЬ  визуальными средствами.  Для этого создайте индекс для таблицы  ЭКЗАМЕН по полю ПРЕДМЕТ  в TableDesigner, открыв таблицу ЭКЗАМЕН. Используем главное меню: View\ TableDesigner, вкладка Fields, поле Index.

5. Используем окно DATA SESSION:
a. В меню выберите команды WINDOW>DATA SESSION.
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b. В окне DATA SESSION щёлкните по кнопке OPEN, откройте таблицу ПРЕПОДАВАТЕЛЬ, а затем  ЭКЗАМЕН.

c. Щёлкните по кнопке PROPERTIES. В открывшемся окне WORK AREA PROPERTIES 
выберите в списке INDEX ORDER в качестве главного индекс ЭКЗАМЕН.ПРЕДМЕТ, щёлкните  OK для возвращения в окно DATA SESSION.
[image: image3.png]Fie Edt View ook

il
Program Window Help
N E S| EEEETE TR
4 Command
USE

rsavien (Dat_lsbi3ksaven) Record 173

cmoa Pmat 9s

aecen~ Iy | serognps \ % 1 O B 4] <

wion AokymenTH\CyBanaGL_vpinpenoaagaten, dbf” IN 0 EXCLUSIVE
USE "c:\wion AokymenTsi\cyBanabul_viphaksamen. dbf” IN D EXCLUSIVE
SELECT2

|l —

Cursor. akaavert

I~ Enable data buifering

Cancel
fr—
|

Bufer

@ e eded

& Cuenteoord
e witen

€ lledted eoords

=

Data it Indes order

Allow access to

[cno orcen>

 lfikds inthe wark area

[BreaverHorep_sa
Gl fields specifed by il fiter Field Fiter.

| o ey,

okcea 2

Database: Dat lab

Records: 9

Exclusive

Qe -L-A-=

Ha 18,8 Cr 21

sag.

Kon 1

oGP

Y

340 WCTP BAT 340 pyconaiiPo O

A yce|||[3g7 Microsoft Visual FoxPro []MerB 122021145 - Micros.. | B) Hoxuver2 - Microsaftvr.. |





d. Установим отношение 1:1. Выберите ПРЕПОДАВАТЕЛЬ, щёлкните по кнопке RELATIONS. Выберите ЭКЗАМЕН, в открывшемся окне EXPRESSION BUILDER выбрать в качестве связующего поле ПРЕДМЕТ таблицы ПРЕПОДАВАТЕЛЬ, щёлкните  OK.
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e. Для установки отношения 1:N щёлкните по кнопке 1-TO-MANY. В окне CREATE ONE-TO-MANY щёлкните по кнопке ALL, а затем OK.
[image: image5.png]Fle Edt View ook Pogam Window Help

D@ SlRlv| i {m(E] (e

L1 | =1 =TS T

4 Command =loix
USE "c:\wou gokymenTeitcyBainabie_vip\aksamen. dbf” IN 0 EXCLUSIVE =
SELECT 1
SET RELATION TO npeauer INTO Sksamen ADDITIVE
B 2[4
i

Curent session: | Defaul(1)
Aliases Relations.
[Farzaren =] Propeties
s any Relationst
Establsh Dne-toMany Relatonship:
Open Fotent Alss i Mpenonasarest
T Chid liases: Selected aliases:

vove | Famen. =

Relations.

Berove

Wark frea: 1 |Records: 4

Remove Al o

ok | carca

o e e W EE—- [ Thun s

acicrem I [aotip- \ W OO B W@ 2-L-A-=S=504.
Ctp. 10 Paal 1015 Hai34n Cr 6 Kond AT WCTE BAT AN pyecewiPo O

A yce|||[3g7 Microsoft Visual FoxPro []MerB 122021145 - Micros.. | B) Hoxuver2 - Microsaftvr.. |

Y





f. Проверьте, как работает связь таблиц. Выполните команду просмотра поля ФАМ таблицы ПРЕПОДАВАТЕЛЬ, поля  НОМЕР_ЗАЧ и ОЦЕНКА таблицы ЭКЗАМЕН.

6. Для создания представления  в окне DATA SESSION выполните команду SAVE AS меню FILE, введите имя файла представления.

7. Закройте все файлы. (CLOSE ALL).

7. Откройте файл представления FILE\OPEN, выбрать тип файла *.vue. Команды SET VIEW ON и затем BROWSE выводят открытое представление на экран. 

8. Создайте представление для таблиц СТУДЕНТ и ЭКЗАМЕН.

9. Используйте представление для просмотра результатов экзаменов.
Контрольные вопросы к работе:

1. Для каких целей используется связывание таблиц?

2. Какими средствами можно связать таблицы?

3. Для чего создаются файлы представления таблиц?
Лабораторная работа №5.

Тема:  «Создание базы данных. Определение свойств таблиц базы данных в Table Designer.  Обеспечение целостности данных на уровне базы данных».

Задания:

1. Создайте новую папку для хранения файлов базы данных.

2. Откройте FoxPro и установите по умолчанию текущей новую папку.

3. Откройте конструктор базы данных- Database Designer.
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4. В окне Database Designer добавьте в базу таблицы СТУДЕНТ и ЭКЗАМЕН (или создайте их вновь).

5. В таблицу ЭКЗАМЕН добавьте поле-дата экзамена.

6. В таблицу СТУДЕНТ добавьте поле-дата рождения студента и место проживания. 

7. Установите следующие свойства и правила контроля достоверности ввода данных в окне Table Designer каждой таблицы (щелчок правой кнопкой на таблице, Modify):

· Всем полям таблиц при отображении установите  русские заголовки (Caption).

· Для таблицы СТУДЕНТ запретите ввод значений номера зачётки меньших 100 и больших 1000 (Rule вкладки Fields). Установите сообщение об ошибке ввода (Message). (Для обеспечения добавления новых записей в окне Browse установите значение по умолчанию-100 (Default Value)).

· Для поля - дата рождения студента установите контроль ввода года рождения студента. Используйте функцию Year(<дата рождения>). Установите сообщение об ошибке ввода. (Для обеспечения добавления новых записей в окне Browse установите значение по умолчанию-{^1985/01/01}).

· Для таблицы ЭКЗАМЕН установите правила контроля ввода значений оценки (не менее 2 и не более 5) и даты экзамена (не позднее сегодняшней даты). Сделайте установку на уровне записей (Rule на вкладке Table).

8. Проверьте установленные правила: в окне Browse для каждой таблицы попробуйте ввести недопустимые значения и проанализируйте результат.
9. Создайте индексы для таблиц по общему полю – НОМЕР_ЗАЧ  студента. Установите тип индекса в родительской  таблице СТУДЕНТ – Primary или Candidate, в дочерней таблице ЭКЗАМЕН –Regular (вкладка Indexes в Table Designer).
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10. В окне Database Designer установите связь таблиц мышкой: выберите индекс, обозначенный ключом в родительской таблице и, удерживая кнопку мыши протяните линию связи к индексу дочерней таблицы. 
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11. Попробуйте проверить результат установленной связи, используйте команду BROUSE. 

12. Упакуйте базу данных: Database>Clean Up.
13. Установите последовательно  различные правила обеспечения целостности данных в базе и проверьте результат их работы. Для этого используйте Database > Referential Integrity. 
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14. В окне Referential Integrity Builder, используйте:

· Вкладку Rules for Updating  для определения, 
[image: image10.wmf]что должно происходить в дочерней таблице при изменении ключевого значения в родительской.

· Вкладку Rules for Deleting для определения, что должно происходить в дочерней таблице при удалении записи в родительской.

· Вкладку Rules for Inserting для определения, что должно происходить при добавлении новой записи или изменении существующей записи в дочерней таблице, если в родительской таблице нет соответствующего ключевого значения.
Установив правило, ответьте на запрос «Генерировать новый код установленных правил…?»  положительно.

Откройте после каждой установки окна Browse для обеих таблиц и проверьте, как работают правила.

14. Выполните действия, в результате которых нельзя добавить новую запись к таблице ЭКЗАМЕН, если в таблице  ПРЕПОДАВАТЕЛЬ нет соответствующего значения поля ПРЕДМЕТ.

15. Выполните действия, в результате которых при удалении записей в таблице ПРЕПОДАВАТЕЛЬ, удаляются все соответствующие записи таблицы ЭКЗАМЕН.

16. Выполните действия, в результате которых при изменении значений поля ПРЕДМЕТ в таблице ПРЕПОДАВАТЕЛЬ автоматические изменения происходят в таблице ЭКЗАМЕН.

17. Создайте локальное представление базы данных. 

· В окне Database Designer выполнить из меню команды:

Database \ New LocalView, выбрать New View (или Wizard);

· В окне Add Table добавить таблицы для которых создаётся представление, Ok;

· В окне View Designer на вкладке Fields выбрать поля таблиц и переместить их (Add>>)  в окно Selected Fields;

· Сохранить представление File \ Save.

· В окне Database Designer добавится представление, дважды щёлкните по нему, появится окно Browse, позволяющее просмотреть поля связанных таблиц представления.

18. Создайте представление VEX.VUE - экзаменационную ведомость по информатике. Ведомость содержит поля таблиц БД: фамилия студента, группа, номер зачётки, предмет, оценка, преподаватель. Выведите ведомость на экран.

Контрольные вопросы к работе:

1. Какие правила контроля достоверности ввода данных вы знаете?
2. Как устанавливаются правила достоверности данных на уровне поля, записи, всей таблицы?

3. Какие правила контроля целостности  данных в базе  вы знаете?

4. Как устанавливаются правила контроля целостности  данных в базе?  
Лабораторная работа №6.

Тема:  Программирование в VFP. Создание простейших программ.

Краткая теория:
Создать программу: File \ New , Program,  New File, в окно Program ввести текст программы, закрыть окно, ввести имя файла программы (тип .prg). 

Исполнить программу:  Program \ Do, выделить имя программы, Do.

Операторы: 

Присваивание - <имя переменной>=<выражение>

Ввод с клавиатуры – Input <’текст’> To <имя переменной>

Вывод на экран - ? <список вывода>

Ветвление – If  <лог.выражение>

                         <оператор1>

                          <оператор 2>…

                      [ Else
                          <оператор1>

                          <оператор 2>…]

                        EndIf  

Цикл параметрический – For <параметр> =<нач.знач.> To <кон.знач.> Step <шаг>

                                              <операторы>

                                            EndFor
Цикл ПОКА – Do While <лог.выражение>

                            <операторы>

                          EndDo
Сканирование таблицы:

Scan  [For<лог.выражение>] 

                                             <операторы>

EndScan   перемещение по открытой таблице от начала до                                    конца, <операторы> выполняются для каждой записи или для тех, у которых <лог.выражение> =< истина>.

Задания:

Напишите программы к каждой из следующих задач:

1. Определить общий балл студента, номер зачётки которого вводится с клавиатуры.

2. Определить количество коммерческих студентов, их фамилии и группу. 

3. По заданной фамилии определить данные о студенте. Повторять поиск по желанию пользователя. Если данные о студенте отсутствуют, вывести сообщение.

Проверьте работу программ.

Контрольные вопросы к работе:

1. Как используются программные файлы при работе с базой данных?
2. Как открыть программный файл?

3. Как исполнить программный файл?
Лабораторная работа N 7.
Тема: «Программирование в VFP. Создание и использование процедур и функций».

Краткая теория:

Процедуры или функции могут быть внутренними или внешними по отношению к вызвавшей их программе. Внешние процедуры и функции могут располагаться в программных файлах (*.prg) или в процедурных (*.prc).

Процедура или функция имеет структуру :

PROCEDURE / FUNCTION  <имя>

PARAMETERS  <список формальных параметров>

<команды>

RETURN [<выражение>]      && по умолчанию выражение=.Т.
Внутренние процедуры или функции прописываются после вызывающей программы. 

Вызов процедуры или функции:

DO  <имя > [WITH <список фактических параметров>]  [IN <имя программного или процедурного файла, содержащего вызываемую процедуру или функцию>]

Функцию также можно использовать, как выражение: 

<ПЕРЕМЕННАЯ>=<ИМЯ ФУНКЦИИ>(<ФАКТИЧЕСКИЕ ПАРАМЕТРЫ>)

В процедурном файле процедуры располагаются последовательно. Для вызова одной из процедур нужно в вызывающей программе прописать команду:

SET PROCEDURE TO <имя процедурного файла> [ADDITIVE]

Опция ADDITIVE используется, если нужны процедуры из нескольких процедурных файлов. Для закрытия файла процедур после их использования вызывающей программе выполнить команду: SET PROCEDURE TO  или  CLOSE PROCEDURE.
Задания:

1. Продолжите программу для вывода на экран из таблицы СТУДЕНТ фамилий студентов и их дней рождения, а из таблицы ЭКЗАМЕН номера ЗАЧЁТОК студентов и даты ЭКЗАМЕНОВ. Используйте функцию, возвращающую значение-название месяца по-русски. Вывод результатов должен иметь следующий вид: 

Иванов И.И. родился 10 декабря 1986 года

Сидоров С.С. родился 20 мая 1988 года

И т.д.
USE СТУДЕНТ IN 1

USE ЭКЗАМЕН IN 2

SELECT 1

CLEAR
SCAN

?  ФАМ, “ РОДИЛСЯ”, NAM(MONTH(ДАТА_РОЖД)), YEAR(ДАТА_РОЖД),” ГОДА”

ENDSCAN

FUNCTION NAM

parameters x

do case

case x=1

NAM='ЯНВАРЯ'

case X=2

NAM='ФЕВРАЛЯ'

case X=3

NAM='МАРТА'

&& И ТАК ДАЛЕЕ..

CASE X=12

NAM='ДЕКАБРЯ'

ENDCASE

RETURN  NAM
В программе используются системные функции для работы с датами VFP:

Day( <врж.D>)-возвращает день месяца указанного выражения.

Year(<врж.D>)-возвращает год указанного выражения.

Month(<врж.D>)-возвращает номер месяца указанного выражения.

2. Создайте процедурный файл, содержащий процедуры: преобразования выражения типа DataTime (10/12/03 10:15:06) к виду-10 часов, 15 минут, 06 секунд и функцию, созданную в задании 1.

3. Проверьте работу процедур из созданного процедурного файла. Составьте программу для вывода даты и времени проведения экзамена по математике в заданной группе. Предварительно измените тип поля дата_экзамена в таблице ЭКЗАМЕН на тип DataTime и введите значения этого поля в таблицу ЭКЗАМЕН. Используйте функции, созданные в процедурном файле, для вывода на экран даты и времени проведения экзамена по математике в заданной группе.

Используйте системные функции времени VFP:

Hour( <врж.DT>)-возвращает время в часах из  указанного выражения типа Time.

Minute(<врж.DT>)-возвращает время в минутах из  указанного выражения.

Seconds(<вржDT>)-возвращает время в секундах из  указанного выражения.

4. Создайте программный код хранимой процедуры для установки триггера на удаление записей  в таблице СТУДЕНТ: Для таблицы  СТУДЕНТ в целом запретите удалять записи, относящиеся к коммерческим студентам (Delete Triggers на вкладке Table).

5. Откройте базу данных.

6. Из окна Database Designer откройте окно хранимых процедур. Для этого выполните из меню Database>Edit Storied Procedures.

7. Пропишите текст кода процедуры: 

FUNCTION DEL_ZAP  && заголовок хранимой процедуры-функции

IF СТУДЕНТ.КОМ
DEL_ZAP=.F.

WAIT WINDOW ‘НЕЛЬЗЯ УДАЛЯТЬ ИНФОРМАЦИЮ !’ && вывод сообщения в окно
ELSE
DEL_ZAP=.T.

ENDIF
RETURN DEL_ZAP     && конец процедуры-функции
8. Закройте окно.

9. Установите значение триггера: для таблицы СТУДЕНТ в окне Table Designer, вкладка Table. Пропишите имя процедуры в поле триггера на удаление записей -      DEL_ZAP()                                                                         

10. Проверьте работу триггера – удалите запись о коммерческом студенте.

Контрольные вопросы к работе:

1. В чём заключается различие внутренних и внешних процедур и функций?
2. В каких файлах хранятся внешние процедуры и функции?
3. Как вызвать на выполнение процедуру или функцию?

4. Для чего используются триггеры и как они создаются?

Лабораторная работа N 8.
Тема: Программирование различных видов меню.

Краткая теория:

Меню обеспечивает пользователю приложения доступ ко всем компонентам приложения. Обычно проект содержит собственное меню, которое заменяет основное меню VFP.  C помощью меню организуется работа с заранее созданными базами данных, таблицами, представлениями, запросами и т.д. 

Горизонтальное меню состоит из нескольких PAD-пунктов (например, File, Edit. View и т.д.). Всплывающее меню (  POPUP ) состоит из нескольких вертикально расположенных пунктов, которые называются BAR и появляются при активизации PAD-пункта (например, New, Open, Save... ). POPUP - меню может использоваться в составе меню более высокого уровня и самостоятельно. 

Определение и активизация главного или POPUP – меню:

DEFINE MENU / POPUP <имя меню> 

<определение составляющих меню (PAD, POPUP, BAR )>
<описание реакции составляющих меню на их выбор>
ACTIVATE MENU  <имя меню> 
Строка главного меню может замещать или дополнять основное меню VFP или отображаться в определённом пользователе окне. 
Создание строки главного меню:

DEFINE MENU <имя меню>

[BAR [ AT LINE ,<номер строки, в которой появляется меню>]]
[IN WINDOW <имя окна, определённого заранее>]
[FONT <имя шрифта>]
[STYLE <имя стиля>]
[KEY <имя клавиши для вызова меню>]
Определение пунктов PAD:
DEFINE PAD <имя PAD-пункта > OF <имя меню, включающего этот PAD-пункт>
PROMPT <’название PAD-пункта’>

!!!! Имя пункта – программный объект, т.е. записывается только латинскими буквами.!!! ! Название может быть любым!

Определение POPUP – меню:

DEFINE POPUP <имя меню> 

[FROM <Y1,X1> TO <Y2,X2>]

[PROMPT <симв. выражение>/ PROMPT FIELD <врж.>]

Определение пунктов BAR-меню:
DEFINE BAR <номер пункта> OF <имя POPUP меню> PROMPT <симв. выражение>

Описание реакции меню на выбор пункта:

ON SELECTION BAR <номер пункта> OF <имя POPUP меню> <команда>
ON SELECTION PAD <имя пункта> OF <имя  меню> <команда>
Активация меню:

ACTIVATE   MENUS/POPUP <имя меню> 
Удаление меню:

DEACTIVATE   MENUS/POPUP
Задания:
1. Создайте горизонтальное меню, из которого можно выполнить действия с БД, созданной ранее:

· Открыть базу данных в окне DataBase Designer,
· Открыть каждую таблицу только для чтения,
· Выполнить поиск данных в БД по различным значениям,
· Отсортировать данные в таблицах,
· Отредактировать каждую таблицу.
2. Создайте вертикальное меню, содержащее исполнение программ, созданных в лабораторной №6.
Контрольные вопросы к работе:

1. Какая команда определяет реакцию выбора пункта меню?
2. Как определяются составляющие меню?
3. Как сделать меню «невидимым»?

Лабораторная работа №9.

Тема: Создание меню средствами Menu Designer.
Краткая теория:

Для создания нового меню выполните команду File > New > Menu. В окне New Menu следует выбрать вид меню:  Menu – линейное Bar-меню или Shortcut – всплывающее Popup-меню. В результате выбора открывается окно Menu Designer:
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В поле Prompt вводится название пункта меню (латинскими буквами!). В поле Result - действие при выборе данного пункта. Если  Result = Command, то в следующее поле записывается соответствующая команда.  Если Result =SubMenu, то появляется справа кнопка Create для создания пунктов подменю аналогичным способом. При создании подменю в окне Menu Level указывается имя пункта верхнего уровня. Если Result = Procedure, то требуется создать (Create) процедуру, которая будет выполняться при выборе данного пункта. Значение BAR# используется для создания системного меню. 
В результате создаётся файл меню  с расширением .mnx.  Для генерирования программного файла меню выполнить команду Menu>Generate в результате создаётся файл меню с расширением .mpr. Меню можно исполнить командой Program>Do или в командном окне(в программе) Do <имя меню>.mpr.
Для восстановления главного меню VFP выполните команду set sysmenu to default.
Задания:
1. Создайте линейное меню со следующими пунктами:

· вывод каждой таблицы созданной БД в окно Browse только для чтения;

· вывод экзаменационной ведомости на экран;
· исполнение программ, созданных в лабораторной работе №6;

· выход из меню и восстановление системного меню VFP.
2. Создайте всплывающее Popup-меню со следующими пунктами:

· активация окна калькулятора (команда activate window calculator);
· активация окна календаря (команда activate window calendar);
3. Добавьте в линейное меню пункт вызова Popup-меню.
4. Сгенерируйте меню и проверьте его работу.
Контрольные вопросы к работе:
1. В чём преимущества и недостатки визуального способа создания меню по сравнению с командным?
2. Для чего требуется генерировать меню, и какой файл создаётся в результате активации.
Лабораторная работа N 10.
Тема: Создание проекта приложения, компиляция проекта.
Краткая теория:

Проект приложения Visual FoxPro 7.0 объединяет базы данных, таблицы, экранные формы, меню, запросы и отчёты, основную программу, которая устанавливает среду и определяет интерфейс пользователя. Описание проекта хранится в файле с расширением .pjx. На основе проекта создаётся файл приложения с расширением .app или исполняемый файл .exe. 

Создание проекта: File \ New \ Project \ New, ввести имя проекта. В результате откроется окно Project Manager (Диспетчер проекта), в котором можно видеть все компоненты проекта и работать с ними. 
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Вкладки Project Manager:  

Data – отображает базы данных, свободные таблицы, запросы, хранимые процедуры;

Documents – формы, отчёты, этикетки;

Code – программы (.prg) и библиотеки;

Classes – классы и библиотеки классов;

Other – меню, текстовые файлы;

All – все включённые в приложение файлы.

Для работы с файлами в Project Manager можно использовать пункт Project верхнего меню или кнопки справа в окне Project Manager: 
New – создать и добавить новый файл (таблицу, базу, форму, меню и т.п.) в проект;

Add – добавить в проект уже созданный файл;

Modify – изменить выбранный файл;

Remove – удалить файл из проекта;

Browse – просмотреть выбранную таблицу;

Build – создать приложение.
Для построения приложения требуется:

· назначить один из программных файлов главным (на файле щ.п.м., выбрать Set Main),

· нажать кнопку Build в окне Project Manager,

· на вкладке Code в окне Project Manager выбрать Application, Add,
· задать имя файл приложения, Ok.(Имя файла-приложения и имя проекта не должны совпадать!).
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Выбрать Build Application для создания файла приложения с расширением .app или Build Executable для создания исполняемого файла с расширением .exe. (При использовании файла *.exe требуется большой объём памяти!)

Задание:
Создайте файл приложения типа .app. В качестве главного программного модуля создать программу, запускающую на выполнение меню, созданное в лабораторной работе №9.

Контрольные вопросы к работе:

1. Какие файлы входят в состав проекта приложения в Visual Fox Pro?
2. Как создать файл приложения?

3. Каково назначение главного программного модуля проекта?
Лабораторная работа N 11. 
Тема: «Создание экранной формы для ввода и редактирования таблиц базы данных в Form Wizard.»
Краткая теория:

Форма – визуальный объект контейнерного типа, который содержит другие объекты. Формы позволяют создавать событийно управляемый интерфейс программ-приложений, работающих с базами данных. Можно создавать формы, пользуясь Form Wizard или Form Designer.

Задания:

1. В окне Project Manager  на вкладке Documents  выбрать Forms, щёлкнуть по кнопке New, выбрать Form Wizard (Мастер форм), выбрать One-to Many Form Wizard.
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2. В окне One-to Many Form Wizard выполните действия:
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· Выберите и откройте в режиме Exclusive родительскую таблицу Студент, а затем поля, которые будут отображаться и редактироваться в форме. Нажмите кнопку Next.
· Таким же образом выберите дочернюю таблицу Экзамен и её поля. Нажмите кнопку Next.
· На следующем шаге можно изменить связь таблиц, если потребуется. Нажмите кнопку Next.
· Выберите один из стилей формы, Next.
· Выберите поле, по которому будут отсортированы данные, Next.
· Выберите вариант завершения работы: просмотр формы, её модификация, сохранение или выполнение.
3. Проверьте работу созданной формы: просмотрите связанные записи таблиц, добавьте новые записи, измените существующие.

4. Создайте  представление для базы данных в Мастере представлений. Представление должно иметь вид экзаменационной ведомости: содержать фамилию студента, предмет, оценку, фамилию преподавателя.

5. Создайте вторую экранную форму для просмотра экзаменационной ведомости в Form Wizard. В качестве таблицы выберите на первом шаге представление и все его поля.

6. Проверьте работу созданной формы.

Контрольные вопросы к работе:

1. Какие средства создания экранной формы используются в VisualFoxPro?
2. Какие шаги при создании формы следует выполнить в Form Wizard?
3. Каковы достоинства и недостатки применения  Form Wizard при создании формы?
Лабораторная работа N 12.
Тема: «Конструирование экранной формы в Form Designer. Создание элементов управления и  обработчиков событий».
Краткая теория:

Открыть проект –File \  Open \ < имя проекта >, Ok.
На вкладке Documents в окне Project Manager выделить Forms, New, выбрать New Form.
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В окне Form Designer появится заготовка окна формы.

Для установки свойств формы и других визуальных элементов на форме используется окно Properties (если его нет, выполнить View \ Properties ) 

При конструировании формы используется панель инструментов Form Controls Toolbar, содержащая элементы управления.
Для установки среды окружения формы требуется выполнить View \ Data Environment.

В окне Data Environment  из контекстного меню (щелчок правой кнопкой мыши ) выбрать Add  и добавить таблицы или представления. После этого создаются  элементы формы и настраиваются их свойства в окне Properties. 
Задания:

1. Создайте формы для просмотра и редактирования полей таблиц ПРЕПОДАВАТЕЛЬ и ЭКЗАМЕН.

2. Создайте форму для связанных таблиц ПРЕПОДАВАТЕЛЬ и ЭКЗАМЕН. Форма должна содержать переключатель, который либо разрешает редактировать поля этих таблиц, либо запрещает.

3. Проверьте работу созданных форм. Отредактируйте форму при необходимости.

Контрольные вопросы к работе:
1. Как настраиваются свойства объектов при создании формы?

2. Каково назначение окна Data Environment?

3. Как проверить функционирование формы?
Лабораторная работа N 13.
Тема: « Создание отчёта к базе данных».
Краткая теория:
Отчёты отображают информацию, которая содержится в базах данных. Для создания отчёта выбрать File > New, Report, выбрать NewFile или Wizard. 

В окне Report Wizard требуется выбрать One – To – Many Report Wizard для связанных таблиц базы.

На первом шаге выбирается родительская таблица и поля для включения в отчёт.
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На втором шаге выбирается дочерняя таблица и поля из этой таблицы. Далее на третьем шаге определяются поля для связи таблиц, а  на  четвёртом – сортировка записей. На пятом шаге определяется вид отчёта и возможно выполнение вычислений над значениями полей для получения итоговых данных. Для этого следует перейти в окно Summary Options:
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В данном примере показано, как подсчитать количество (Count) домов на каждой улице. На шестом шаге предлагается сделать предварительный просмотр (Preview) отчёта, сохранить отчёт в файле, вывести на принтер, отредактировать отчёт в конструкторе. 

Созданный отчёт хранится в файлах с расширением .frx или .frt.  Файл отчёта можно вывести на экран, принтер или в файл. Для этого служит команда:

Report Form  <имя отчёта> To Printer [Prompt] / Preview / To File <имя файла> 
Опция Prompt выводит на экран диалоговое окно Print для установки параметров принтера. Если используется вывод отчёта в файл, то по умолчанию создаётся файл с расширением .txt. 
В качестве источника данных для отчёта можно использовать локальные представления, но при этом выбрать Report Wizard перед первым шагом в мастере отчётов.
Задания:

1. Создайте следующие отчёты к базе данных:

· Данные о студентах, упорядоченные по группам (выбрать Report Wizard), с указанием количества студентов в каждой группе и всего в таблице.

· Данные о преподавателях,  упорядоченные по фамилиям (выбрать Report Wizard).

· Сводную экзаменационную ведомость (выбрать One – To – Many Report Wizard). Ведомость должна содержать сведения о среднем балле для каждого студента. 
2. Создайте программный файл, в котором по желанию пользователя выводился любой отчёт на экран или в файл, или на принтер.

 Контрольные вопросы к работе:
1. Какими могут быть исходные данные для создания отчёта?

2. Как можно использовать файл отчёта?

Лабораторная работа №14. 
Тема: «Изучение команд SQL для выполнения изменения данных
и поиска данных в базе»
Краткая теория.

Structured Query Language (SQL) – язык, который используется для анализа таблиц и баз данных через запросы (Query).  В настоящее время SQL является самым распространенным языком обработки данных в реляционных и объектно-реляционных СУБД.

Назначение SQL состоит в том, чтобы максимально упростить обработку информации и дать разработчику сосредоточиться на решении проблемы, не вникая в механизм ее реализации. Основные черты SQL:

· обработка групп данных, а не отдельных элементов;

· обеспечение автоматического перемещения по таблицам баз данных;

· использование отдельных утверждений для выполнения сложных операций над данными.

Команда  SELECT является единственным оператором поиска и выборки данных и реализует все операции реляционной алгебры. Эта команда предназначено для создания запросов, извлекающих из базы данных информацию, удовлетворяющую заданному критерию. Простейшая форма запроса, возвращающая все содержимое таблицы, реализуется с помощью символа звездочки (*): 
SELECT * FROM database
В формате  SELECT есть следующие  основные блоки:

· DISTINCT – содержит имена полей, которые выбираются; имена могут быть составными, указывающими имена рабочего поля или таблицы;
· FROM - перечисление имён таблиц или рабочих областей, из  которых выбираются поля в результат запроса;
· WHERE – условие поиска данных в нескольких таблицах;
· GROUP BY – группировка записей в порядке возрастания значений одного или нескольких полей;
· HAVING  - включает в запрос столько групп, сколько задано условием;
· ORDER BY – позволяет сортировать результаты запроса по возрастанию (ASC) или по убыванию (DESC).
· INTO TABLE <имя таблицы>/  TO FILE <имя текстового файла> /  TO PRINTETR – результат запроса направляется в таблицу или в файл, или на принтер.
Задания:

1. Напишите запрос, в результате которого выводятся оценки студентов заданной группы по всем предметам.

2. Создайте таблицу, в которой содержится список преподавателей и групп, в которых они преподают. Упорядочить записи по группам. Использовать команду SELECT.
3. Создайте текстовый файл, содержащий результат запроса: экзаменационную ведомость.
4. Дополните  созданное меню проекта приложения пунктами, позволяющими сделать доступ к результатам созданных запросов.

Контрольные вопросы к работе:
1. Какие команды языка FoxPro реализуют действия аналогичные команде Select?

2. Как можно использовать результат запроса?
Лабораторная работа №15.
Тема: «Создание запроса в окне Query Designer»
Краткая теория.
Для создания запросов визуальными средствами в VFP используется Query Designer или Query Wizard. Построение запроса в Query Designer аналогично созданию представлений к базе данных.  Окно Query Designer имеет следующий вид:
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В верхней части окна находится содержимое отобранных таблиц или представлений. В нижней части находится шесть вкладок, предназначенных для построения запроса:

· Fields – вкладка для выбора полей таблиц или представлений для запроса;
· Join – определяется источник данных. 

 При этом устанавливается следующий тип:

· Inner Join – запрос содержит только совпадающие строки таблиц,

· Left Join – все строки левой таблицы и связанные с ней строки правой,

· Right Join – все строки правой таблицы и связанные с ней строки левой,

· Full – все строки обеих таблиц.

Для определения типа перейти в окно Join Condition нажать  (, левее Type.
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· Filter – используется для фильтрации данных по заданному условию;

· Order By – сортировка данных в запросе;

· Group By – группировка данных в запросе;

В области FUNCTION FND EXPRESSION можно создавать вычисляемые поля результата запроса. 
Команду SQL, которая генерируется в результате создания запроса, можно просмотреть, если в конструкторе запроса из главного меню выбрать Query>View Designer.
Результат запроса сохраняется в файле с расширением *.qpr. Файл запроса можно запустить на выполнение, как любой программный файл. По умолчанию результат запроса выводится в окно Browse. Можно вывести результат запроса (при исполнении файла *.qpr) в отчёт, на экран, в таблицу и т.д., если в конструкторе запроса из главного меню выбрать Query>Query Distanation. 

Задания:
1. Создайте запрос к базе данных в конструкторе запросов. В результате запроса должны выводится СВЯЗАННЫЕ  записи из таблиц СТУДЕНТ и ЭКЗАМЕН только для коммерческих студентов.

2. Добавьте в результат запроса  вычисляемое поле для определения суммы баллов каждого студента по результатам экзамена.

3. Создайте отчёт по результатам запроса.

4. Выведите на экран результаты запроса.

Контрольные вопросы к работе:
1. Для каких целей создаётся запрос к базе данных?

2. Как можно использовать результат запроса?
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